Ubuntu Utilities J

Introduction

As discussed in the previous chapter, Ubuntu is a very popular operating system which is available
for free. Ubuntu offers a variety of software tailored for day-to-day users, providing a user-friendly
and productive experience. For example, Ubuntu provides the Firefox web browser for accessing
the internet. It has an office productivity suite named LibreOffice, which can be used to create
documents, spreadsheets, and presentations. Thunderbird manages emails efficiently, and
Rhythmbox offers music playback and audio library management. Shotwell helps organize and edit
photos, while Totem handles video playback. Ubuntu Software Center allows users to explore and
install additional apps like VLC, GIMP, or Spotify. These tools are free, open-source, and regularly
updated, making Ubuntu a reliable choice for everyday computing tasks such as work,
communication, and entertainment. In this chapter, we will study some useful Ubuntu utilities, i.e.
application programs which can be useful in day to day tasks.

n

Calculator Unde Basic v

The Ubuntu Calculator,
commonly referred to as
GNOME Calculator, is a
built-in application
included with Ubuntu
and other Linux |
distributions using the
GNOME desktop

environment. It is a _ [ : g :
powerful, lightweight, 7 8 9
and user-friendly utility

designed to perform a 4 S 5 2]
wide variety of 1 2 3 N
calculations. The

Calculator provides a 0 . % +

clean and intuitive

interface suitable for Figure 5.1 : Basic Calculator

both basic arithmetic and advanced mathematical operations. As shown in figure 5.1, the basic user
interface of the calculator is similar to a physical calculator which makes it very easy to use. The
calculator has a minimalist and modern user interface, designed for clarity and ease of use. Buttons
are well-organized and labeled, making it accessible for users of all skill levels.

The basic calculator interface includes number keys, operator keys (addition, subtraction,
multiplication, division, etc) and result key (=). You may press any key using the mouse or
equivalently you may enter numbers from the keyboard to perform the desired operation.
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Apart from the basic view shown in figure 5.1, Ubuntu Calculator also supports other task specific
calculators. Following is the list of various modes available in Ubuntu Calculator.

We can easily switch

Basic Mode — Designed for everyday arithmetic operations such as addition,
subtraction, multiplication, and division. This mode is ideal for quick and simple
calculations.

Advanced Mode — Includes scientific calculator functions like trigonometric operations
(sine, cosine, tangent), logarithms, exponentiation, square roots, and more. It supports
parentheses for complex expressions and provides precision suitable for engineering
and science students or professionals.

Financial Mode — Offers functions commonly used in financial calculations such as
interest rate, loan payments, and investment returns. This is particularly helpful for
individuals managing personal finances or professionals dealing with financial
planning.

Programming Mode — Provides features useful for developers and programmers,
including support for binary, octal, decimal, and hexadecimal number systems. It also
allows bitwise operations and conversion between different bases.

Keyboard Mode — Enables full operation of the calculator using keyboard shortcuts,
making it efficient for power users who prefer to work without a mouse.

Date Calculation Mode — Allows users to calculate the difference between two dates or
add/subtract days from a given date, which is useful in scheduling and planning tasks.
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between modes
through a drop-down
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bar. The application
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discuss two modes
of Calculator, i.e.
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for our day to day
work.

Advanced Mode

Advanced mode, also known as scientific mode, provides access to more complex scientific
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Figure 5.2 : Scientific Calculator (Advanced Mode)

functions. Figure 5.2 shows the Ubuntu Calculator interface for advanced mode.
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As shown in figure 5.2, there are many more buttons on the right side panel compared to the basic
mode of figure 5.1. These buttons refer to different scientific functions. For example, to calculate 23,
we first press the number key 2, then press the key X ¥ and then press the number key 3. Finally press
the resultkey = and we will get § as the answer.

Financial Mode

Figure 5.3 shows the financial model of Ubuntu Calculator. Again on the right side panel you may
see various keys required for advance financial calculations.
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Figure 5.3 : Financial Calculator

To calculate the remaining terms for a borrowed loan, we use the 7erm key and enter four values,
rate, payment, present value and future value. For example, 'If we borrow 310,000 at 8% annual
interest, making monthly payments of ¥500. How many months will it take to repay the loan?' This
can be easily calculated as follows, press the 7erm key and enter the following numbers: 0.0066667,
-500, 10000, 0. Finally press = key and you will get the answer.

GEDIT-Text Editor

Gedit is a free and open-source text editor developed as part of the GNOME project. It is included by
default in many Linux distributions, including Ubuntu. Gedit has a minimalist and intuitive user
interface, making it easy for new users to get started quickly. The main window consists of a menu
bar, toolbar, and a large central editing area. Tabs allow for multiple documents to be open at the
same time, supporting multitasking and productivity. While it is primarily known for its simplicity,
Gedit also supports a wide array of advanced features, such as syntax highlighting, auto indentation
and remote file editing. Figure 5.4 shows the basic Gedit interface.
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Figure 5.4 : Gedit Interface

As shown in the figure 5.4, the main window consists of a menu bar, toolbar, status bar and a large
central editing area. The Menu bar at the top, allows us to open and save a file. The filename is
displayed at the center of the top menu bar. The Status bar at the bottom shows file statistics, e.g. file

type, number of lines, columns, etc.

While the basic interface looks very simple and easy to use, Gedit provides some interesting features

like,

e  Tabbed Interface: Open and manage multiple documents simultaneously.

) Status Bar: Displays useful information such as line number, column position, and

syntax mode.

° Font and Color Customization: Allows users to choose themes and adjust font styles

to improve readability and personal comfort.

We can access these features by clicking the three line icon located near the Save button. As shown in
figure 5.5, clicking on the Three line Icon located next to the Save button opens the Options menu of
Gedit. Atthe top you can see icons for Refresh, Print and to Maximize the window.
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Figure 5.5 : Gedit Options
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The other Menu options available are as follows.

New Window: We can open multiple instances of Gedit Window by clicking on New Window
option. Also, in each window, we can create multiple tabs to open more than one file. The 7ab icon is
located next to the Open button at the top left corner.

Save and Save all: By clicking the Save button at the top right of the menu bar we can save the file in
the hard disk. However, if we want to rename a file, we can use the Save 4s... option. Clicking on
Save As ... opens a dialog box, where we can specify a new name for the file. Also, we can specify a
new location to store the file. If we have opened multiple files in different tabs, we can save all these
files in one click by choosing the Save A/l option.

Find and Replace: Find and Replace... is a very useful option for text editing. If we want to check
whether a file contains a specific text or phrase, we can use the Find option. If we have misspelled a
word in the text file and want to correct the spelling, we can use the Find and Replace option and
replace the incorrect spelling with the correct one.

Go to Line: Gedit maintains line numbers, which can be seen at the beginning of the text string.
While editing a large text file, we can directly jump to a specific line number using the option Go to
Line...

View and Preference: While the default Gedit information is very minimalistic and simple, we can
customize it based on our liking. By choosing from various View options, we can change font,
background, and other aspects of the appearance of the Gedit interface. Preference options allows
us to modify the behavior of Gedit in a way that helps you in effectively performing the text editing
tasks.

Tools: The Tools option will provide access to some advanced text editing options like spell
checking, language selection, date and time insertion etc.

File Browser

Ubuntu comes with a file browser software called Nautilus. The Nautilus file browser (also known
as Files) is the default file manager in Ubuntu and other GNOME-based Linux systems. It provides a
graphical interface for managing files and directories. Whenever we open any directory location
e.g. home directory, it actually opens in the Nautilus file browser. It allows us to browse files as well
as directories. Figure 5.6 shows a sample Nautilus screen.

The main components of File browser shown in figure 5.6 are,

(1) MenuBar/App Menu (Optional)

° Located at the top or integrated into the title bar (depending on your desktop
environment).
e  Providesaccessto Preferences, Help, About, and Keyboard Shortcuts.

(2) Toolbar/Header Bar
Located at the top of the window. It includes,
e  BackandForward navigation buttons to navigate through folder history
e  Pathbar which shows the current folder path and allows clicking to navigate.
) Search icon which opens a search bar to find files/folders.
e  View options button which allows switching between list view, grid view, sort
files, etc.

e  New folder/Action buttons to create folders or access additional options.
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5.6 : Ubuntu File Browser (Nautilus)

(3) Sidebar (Left Pane)
Located on the left side of the window, it provides quick access to:

° Home, Desktop, Documents, Downloads, etc.

° Mounted drives and network locations.

° Trash and Other locations.

° Allows drag-and-drop for copying or moving files.

(4) ViewArea (Right Pane)
(a) Itdisplays the contents of the current directory.
(b)  There are two main viewing modes: (1) Icon view which shows thumbnails or

icons arranged in a grid. (2) List view which gives a detailed view with columns
like Name, Size, Type, Date Modified.

(c)  Supports drag-and-drop, right-click menus, and keyboard shortcuts.

Opening Files and Directories

The file and folder shown in File viewer can be opened by simply double clicking the mouse over it.
A folder opens in the same Nautilus window, replacing the current display of the content pane with
the contents of that folder. When you double-click a file, Ubuntu tries to find out the most appropriate
program for opening it. For example, text files open in the Gedit text editor, LibreOffice files open in
their respective LiloreOffice application, image files (pictures) open in the Eye of Gnome
application, music files open with Rhythmbox music player and video files open with the Totem
Movie Player. Right-clicking on a file gives us an option to choose the appropriate program to run or
open that file.
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Once we have opened multiple folders the forward/backward navigation button in the Nautilus file
browser becomes enabled. We may use this button to go back to the previous folder. Once we go
back, the forward button becomes enabled. This button can be used to return to the folder from where
we 'went back'. Just above the content pane, you can see a list of directories that need to be traversed
to reach the current directory from the root directory. You may click on any of these directories to
directly open it. Even after you open a parent directory, Nautilus tries to retain the child directories in
this list in case you may want to visit them again.

Different Views in Nautilus (GNOME Files)

Nautilus offers three different ways to look at the list of files and directories in the current directory.
These are the icon view, the list view and the compact view. By default it opens an icon view similar
to the one shown in figure 5.6. The view can be changed either by using the view selection tool near
the right hand side of the toolbar, or the shortcut keys CTRL+1, CTRL+2 and CTRL+3 can be used.

In the icon view, each object is represented by an icon (depending on its type) and its name. For many
types of objects, the icons may even provide a thumbnail (a small preview of the object's contents)
also. The icons are arranged in a grid form.

In the compact view, the objects are represented by very small icons (no preview) and names and are
arranged in a vertical list. The list view displays several other details about the files like its size, type
and the date when the object was last modified (date of last modification). In this view, we may sort
(arrange) the objects in the ascending or descending order of any of the displayed columns by
clicking once or twice on the column heading. This is very useful to find, say, the largest file or the
latest file. Figure 5.7 shows the list view of File browser.
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Figure 5.7 : Nautilus File Manager: List View
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Performing File Operations

The right click of the mouse on any file opens a context menu, as shown in the figure 5.8, through
which various file operations can be performed.
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Figure 5.8 : Context Menu for a File

Figure 5.8 shows a context menu for an image file. Through this menu we can perform the following
operations,

° Open: Open the file using a default program or choose the program which you want to
use to open the file. In figure 5.8 the default program suggested is 'image viewer' and
clicking on the string 'Open With other Application' allows the user to select a program to
open the file.

° Cut and Copy: Clicking on Cut or Copy allows you to cut or copy the file which you
may later paste in some other directory. Alternatively you may also use keyboard
shortcuts Ctr/+X or Ctrl+C to perform the task. In the Cut operation file will be removed
from the current directory.

° Move to and Copy to: If the destination folder is predefined then instead of Cut or
Copy, we may directly use Move to... or Copy to... command to move files into a
different directory.

° Move to Trash: Trash is a temporary location where the deleted files can be stored, if we
do not want to permanently remove it from the hard drive.

GNU Image Manipulation Program (GIMP)

GIMP, short for GNU Image Manipulation Program, is one of the most powerful and versatile open-
source image editing applications available for Ubuntu and other Linux-based operating systems. It
serves as a free alternative to commercial tools like Adobe Photoshop, offering an extensive range of
features for photo retouching, image composition, graphic design, and digital art. When we open the
GIMP by double clicking on its icon, the GIMP home screen appears as shown in the figure 5.9.
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The GIMP interface is very rich and highly customizable as shown in figure 5.9. The key
components of GIMP Interface are as follows.

° Menu Bar: Located at the top, the menu bar houses core commands like File, Edit,
Select, Image, Layer, Colors, Filters, etc.

° Toolbox: Located in the left panel of the window, the toolbox contains selection tools,
brushes, pencils, and color tools

° Image Window: The center area of the screen is known as image window which
displays the current canvas

° Creative Control: The right side of the panel provides access to Brushes, Patterns, etc.
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Figure 5.9 : GIMP (GNU Image Manipulation Program)

The figure 5.9 shows a default view of the GIMP interface, however the interface can be configured
to suit different workflows. It provides a multi-window or single-window mode, with dockable
panels and toolboxes that can be rearranged and saved as workspaces. Now, let's perform some
image editing tasks on GIMP.

Opening and Creating Images

GIMP allows users to create a new image or to edit an existing image. It supports a wide range of
image file formats, including JPEG (JPG), GIF, BMP, PNG and SVG. By clicking on the file menu
(top left corner of figure 5.9), we can choose to open an existing image or create a new image. The
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image will be displayed on a canvas placed in the central area of the image editor. We can specify the
size of the canvas while creating an image. The usual preferred size of the canvas is 800 X 600 pixels.
A pixel is the smallest dot that makes up a picture on a screen. On your computer, tablet, or phone
screen everything you see, like photos, games, and videos, is made up of millions of these tiny dots.
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Figure 5.10 : Opening an Image

Basic Image Editing Tasks

Figure 5.10 shows an image loaded on the GIMP interface. Once the image is loaded, we can
perform many editing tasks on the image. Some of the common image editing tasks are as discussed
below.

Resizing: Resizing means changing the size of the whole image, making it bigger or smaller.
Resizing is a very useful task as we often want to see an image on a different screen size. Also, when
we want to print the image, we need to resize it to fit the size of the paper.

To resize an image, click on the image menu and choose the scale option. The scale dialog box will
allow us to specify height and width to which we want to resize the image, as shown in the
figure 5.11.
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Figure 5.11 : Resizing an Image

Cropping: Cropping means cutting out parts of an image to keep only the area we want. For
example, if we want to remove an unwanted background image, or we want to cut out a portrait from
alandscape photo, we can use cropping.

To crop an image, we first select the crop tool from the toolbox available on the left panel. Once the
crop tool is selected, we hover the mouse over the image and click and drag over the area we want to
keep. Once the area is selected as shown in the figure 5.12, press enter to crop the image.
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Figure 5.12 : Selecting an Area of the Image Using Crop Tool
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As we can see in figure 5.12, the selected highlighted area will remain and the darker area will be

cropped out. figure 5.13 shows the image after the crop operation.
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Figure 5.13 : Cropped Image

Rotating: Rotating means turning the image around at a specified angle. Sometimes when we
click a photograph, we feel that the image is a bit slanted, or sometimes just for experiment we want
to rotate the image to provide a better view angle. These tasks can be performed by choosing the

transform option from the Image menu.
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Figure 5.14 : Image Transform Menu Options
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As shown in figure 5.14, GIMP provides many image transformation options, like rotate, scale,
shear, flip, perspective, 3D transformation etc. Once, we choose Rotate option, a dialog box will

open as shown in the figure 5.15
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Figure 5.15 : Image Rotate Operation

Brightness, Contrast and Color Management: Often when we click a photo, due to low
light we get a darker image. Also, if there is very bright sunlight behind the subject, we get darker
faces of the subject. This kind of varying exposures in the photographs can be corrected by adjusting

brightness and contrast of the image.

In the Image menu, the color option provides different methods for brightness and contrast
adjustment. Alternatively, we can access the brightness and contrast adjustment function from the
toolbox also. Figure 5.16 shows brightness and contrast adjustment dialog box.

By sliding the brightness and contrast bar shown in figure 5.16, we can check its effect on the image.
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Figure 5.16 : Brightness and Contrast Adjustment Tool
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There are various other options available to improve the overall visibility of the image. Some of the
useful options are, hue and saturation adjustment tools, levels and curve tools, etc. All these options
can be accessed through the image and tools menu.

Creating a new image: So far, we have seen how an existing image can be modified using GIMP.
Now we will see how a new image can be created in GIMP. As we have discussed earlier, to create a
new image, we first go to the file menu and click on 'New'. It will open a new image dialog box.
Specify height and width of the pixel and click OK to open a blank canvas.

Once the canvas is open, we can use drawing tools to draw the image and then use painting tools to
color the image. The right side panel of figure 5.9, shows various types of brushes available for
drawing. Some of the popular drawing and painting tools available in GIMP are,

° Paintbrush: Itisused for freehand drawing.

° Pencil: Itis used for hard-edged strokes.

° Bucket Fill: Itis used to fill an area of the image with the chosen color.
° Gradient Tool: Itis used to create color transitions.

° Eraser: Itisused to remove some parts of the image

Once the image is created, it can be saved in .xcf format. This file can again be used later for further
editing. Once the image is finalized, it can be exported in standard image format like .png and .jpeg.
Go to File menu and choose export option to make a jpeg or png file of the image.

Summary

An operating system provides many useful utilities which can be useful in our day to day office
activities. In this chapter, we have seen some applications available on the Ubuntu system. Many day
to day tasks like calculating, writing text files, and storing data in directories can be easily done by
the tools that we have studied. We have also studied a powerful Image Manipulation Program GIMP
which can be useful to photography and painting enthusiasts. All the software we have discussed are
freely available and perform as good as their paid counterparts.

We have learned how to use Ubuntu systems to perform our daily tasks. Apart from the utilities or
applications discussed in this chapter, there are other applications which can be equally useful,
namely Totem movie player, LibreOffice productivity suite, Rhythmbox music player etc. Since the
Ubuntu interface is consistent across the applications, we can easily explore and use these
applications.

EXERCISE

Which are the different modes available in Ubuntu Calculator?

What are the key features of Gedit text editor?

Explain how we find and replace a word in Gedit.

Which are the different view modes available in Ubuntu File browser (Nautilus)?
What information do we get in the list view of Ubuntu files?

SR B =

Suppose you want to become a graphic designer, which utility software you would use for your
day to day job?

>

Describe the use of the Crop tool in GIMP image editor.
8.  Whatare the different file formats supported by GIMP?
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9.  Whatisapixel?
10. How do we set the size of an image in GIMP?
11. State whether true or false.
(1)  We cannot open multiple files in Gedit.
(2) Ubuntu Calculator does not support financial mode.
(3) Afilemovedto trash cannot be restored.
(4) Wecansearch afile by its partial name in the Nautilus file browser.
(5) Filebrowserallowsusto sortfiles by the date of creation.
12. Fill-in the blanks.
(1) Wecancreate files in Gedit.
(2) _ modeofcalculator provides power function.
(3) Totallinesinafileisdisplayedin of Gedit.
(4) A.jpegfilecanbeopenedin  program.
(%) isused for freehand drawing in GIMP.
13. Multi-choice questions. Choose the most correct answer.
(1)  Which of the following modes is NOT available in the Ubuntu Calculator by default?
(a) BasicMode (b) Scientific Mode (c) Financial Mode (d) Graphing mode
(2)  Whatis the main purpose of the 'Financial' mode in the Ubuntu Calculator?
(a) Tosolvealgebraic expressions
(b) Toconvertcurrencies
(c) To calculate interest, annuities, and other finance-related values
(d) To solve statistical problems
(3)  Which of these operations can be performed in the 'Scientific' mode of Ubuntu
Calculator?
(a) Bitwise logical AND and OR
(b) Matrix multiplication
(c) Trigonometric calculations like sin, cos, tan
(d) Image rendering calculations
(4) What is the primary purpose of Gedit in Ubuntu?
(a) Managing system files (b) Editing plain text files
(c) Browsing the internet (d) Playing multimedia files
(5) Which of the following is not a feature of Gedit?
(a) Opening multiple files simultaneously
(b) Opening multiple windows of Gedit
(¢) Finding a replacing a text string
(d) Creating tables and storing numbers in it
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(6) What is GIMP primarily used for?

(a) Writing code (b) Image editing and graphic design
(¢) Audio mixing (d) 3D modeling

(7)  Which file format is GIMP's native format used for saving projects with edits
preserved?
(@ .Jpg (b) .png (c) xef (d) .gif

(8)  Which of the following is TRUE about GIMP?
(a) Itis a paid software available only for Windows
(b) It does not support third-party plugins
(c) Itis open-source and available for multiple platforms
(d) It only works with vector graphics
(9)  Which GIMP tool is best used to remove unwanted parts of an image by cutting them

out?

(a) Scale Tool (b) Crop Tool (¢) Smudge Tool (d) Paths Tool
(10) Which GIMP tool is used to resize an image?

(a) Scale Tool (b) Crop Tool (c) Paths Tool (d) Smudge Tool

Laboratory Exercise

1.  Perform the following file operations using Gedit

Create two text files named first.txt and second.text

Open both files in separate tabs.

Write a paragraph about cricket in first.txt

Write a paragraph about football in second.txt

Count how many times the word 'cricket' occurs in the first.txt file.

Count how many times the word 'football' occurs in the second.txt file.

Find the word 'cricket' in the first.txt file and replace it with the word 'football'.

R ™o Ao T

2. Using Ubuntu Calculator perform the following tasks

a. Calculate (1200*30)/50-100

b.  Calculate hypotenuse of a triangle using Pythagoras formula.

c. Calculate area of a rectangle.

3.  Perform the following tasks using GIMP

a. From an image which contains a group of people, extract the image of a single
person.

b.  Invert an image
Convert an color image into a grayscale image
Draw an image of your choice and fill colors in it. Export it as a jpeg file.

/
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